YOUR FIRST OSLO SESSION
1.

Introduction

This document gives a click-by-click description of how OSLO can be used to carry
out a very simple task involving synthesis, analysis, and optimization of a spherical
concave mirror. It is in general applicable to all editions of OSLO, including OSLO
EDU. This means that more advanced facilities, which may only be available in
OSLO Standard and Premium editions, are not included.
The exercise will demonstrate the two main modes of calculation, the geometrical
approximation, in which light is treated as a ray, and physical, in which the light is
treated as propagating as a wave front, and the results take account of diffraction.

Symbols used in this chapter
A left-click on the mouse is indicated by a white arrow, and a right-click by the box
with the word “Right”. If a drop-down menu is selected by a leftclick, then it is represented by a black circle and arrow.
Step by step instructions are marked with bullet points. Instructions
about what to do if things go badly wrong are in italics and labeled

HELP! .
Anything typed from the keyboard (whether as a command or as an
entry in a dialog box) is shown in this typeface.

Right

Labels and headers in spreadsheets and dialog boxes are given in bold.
Buttons to be clicked are shown in _grey_.
Check-boxes (called “radio buttons” in the documentation) are shown like this:
Messages which appear whenever the cursor hovers above an icon are shown in a
shaded box. These are known as tool-tips.
Tool-tips
Questions and answers, representing a typical dialog between a lens designer and
the customer, are given in bold type.

2.

The user interface

A number of terms are defined here, and given in bold print.
At the top of the main window in the blue border is the title bar, which gives the
lens identifier, the file name under which the current lens was last saved, and the
edition of OSLO which is running.
Beneath this lies a row of menu headers, File, Lens, Evaluate, etc, each of which
has its own drop-down menu. Many of the program commands can be accessed
through these menus. The last of the menu headers is Help which gives access to
the on-line documentation. In Windows, this can also be accessed via the F1 key
on the keyboard.
Setup Window/Toolbar

Below that is a row of icons forming the main window
toolbar, which give one-click access to the most frequently
used control functions. The first of these is the Setup
Window/Toolbar icon which gives access to a list of further groups of icons which
can be added to the toolbar. Other icons are to Open surface data spreadsheet,
Open a new lens, Open an existing lens, Save the current lens, Open the
standard text editor, etc. Each icon has a description of its function which pops up
as a tooltip.
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At the bottom of the main window, there is a status bar which can be expanded
and customized by the user.

MAIN WINDOW

Title bar
Menu headers

Toolbar
Command line
Toolbar

Surface data
spreadsheet

Graphics
window

Toolbar

Text window

Status bar
The window which opens in the top left hand corner is called the surface data
spreadsheet. This is the area where all the properties of the lens and its working
conditions are defined. Other spreadsheets are available, but only one spreadsheet
can be open at a time.
Open surface data spreadsheet

HELP! If the surface data spreadsheet does not open,
click on the blue lens icon on the left of the toolbar in the main window.
Alternatively, select from the Lens menu header the option Surface
Data Spreadsheet....
Immediately above the surface data spreadsheet is the command line where OSLO
commands are typed. They are executed either by pressing Enter or by clicking on
the green tick:
Accept pending entry/Close spreadsheet

Online documentation for any command may be accessed by typing the command
in the command line, and then pressing the yellow question mark beside it.
Help for the command/spreadsheet

If no command is entered the documentation for any currently open spreadsheet is
given.
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Below the command line there is a message area, and on the right hand end there
is the history button.

There should also be a text window visible. This is where printed output is
directed. Along the top of this there lies a toolbar consisting of a row of text labels,
which are OSLO commands, executed by clicking.

HELP! If the text window toolbar does not look like the one in

Setup Window/Toolbar

the diagram, click on the Setup Window/Toolbar icon in the
top left-hand corner of the text window, and select
Standard Tools from the menu. Any or all of the toolbar
groups may be selected for a text window. Either one or two,
but not more, text windows can be shown at a time.
The user may create additional toolbar entries using
the CCL programming language.

Also on the main screen there is at least one graphics window. This has a toolbar
consisting of a row of icons. All graphical output is displayed in one of the graphics
windows.

HELP! If the graphics window toolbar does not look like the
Setup Window/Toolbar
one in the diagram, click on the Setup Window/Toolbar icon
on the left-hand side of the graphics window toolbar, and select
Standard Tools from the menu. Only one of the graphics
window icon groups may be displayed at a time, but different graphics windows may have
different groups. Up to 30 graphics windows may be created and displayed by the user at
any one time. Two more may be generated automatically.
HELP! If you have trouble finding the text window or the graphics window, then from the
Window menu header select Tile Windows Alternatively type the command tile into
the command line and then either click on the green tick or press  (Enter) on the
keyboard.
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3.

Spherical mirror example

The remainder of this section will consist of instructions on how to specify a
concave spherical mirror of radius 16 mm, and then to assess its on-axis
performance at apertures of f/4 and f/2.3. Finally its performance at 18° off axis will
be assessed, and the stop position and image radius of curvature optimized to give
the best performance over the field of view.
For clarity, each section will be prefaced by a question from a “customer,” given in
bold type.

2 mm
R = 16
8 mm

Question:
Does a spherical mirror working at f/4 give a “diffraction
limited” image at its focus when used with a 2 mm diameter parallel axial
beam of green light?

3.1

Defining the lens system data

The working conditions of the lens (such as units, paraxial setup data, wavelengths
and field points) are defined by entries in the surface data spreadsheet above the
double line.

Accept pending entry/Close spreadsheet

6

2

3
1

1

5
1
4
1

On the surface data spreadsheet:
1. Left-click with the mouse on _Draw Off_ to open the Autodraw window.
The label on the button changes to _Draw On_ while the Autodraw window
is active.
2. Add the lens identifier (up to 32 characters): Lens: Spherical mirror
Click once on the green tick.

HELP! If you were to choose a different name for the lens identifier, and the name
happened to be a valid OSLO command words (such as spe), the name would be rejected
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and the relevant command executed instead. To avoid this, the title might be enclosed in
quotation marks: e.g. “spe”.
The default value of Ent beam radius is 1.0 mm, the default primary wavelength is
0.58756 µm (the green helium d-line), and the default units are mm, so for this
exercise these do not need to be changed. Also at this stage it is only necessary to
assess the mirror on axis, so the field angle does not need to be changed from the
default value of 1 milliradian.

Defining the lens surface data
Turning now to the data below the double line, the first line (labeled OBJ) refers to
the object space, numbered 0. A parallel beam is the default condition for a new
lens. So the THICKNESS - that is the object distance - is infinity (in OSLO, that
means 1020, written 1.0000e+20 lens units). Nothing has to be changed on this
line since in the object space a medium (GLASS) of AIR is also the default. The
object radius (1.0000e+14) is calculated from the field angle by the program, and is
not specified by the user.
On the second line for surface 1 (AST):
3. Because the aperture is “f/4” the focal length must be 4 times the beam
diameter of 2 mm, and the focal length is half the radius of curvature.
Change the RADIUS to:-16 (mm). Since this is measured from the surface
to its center, a negative radius implies a surface concave to the incoming
beam.
4. Click on the grey button next to AIR under GLASS and select Reflect
(hatch) (or Reflect - the only difference being the appearance of the
drawing).
5. Change the THICKNESS from 0.000000 to: -8 (mm). This is the
separation from surface 1 to surface 2. It is negative because after reflection
the light travels in the opposite direction to the local z-axis.
6. Once again, click on the green tick (

) to confirm the changes.

Note that for surface 1, the APERTURE RADIUS (1.000000) has AS in the grey
box next to it. A means that this surface is the aperture stop. S means that the
size of the surface is governed by a “paraxial solve,” which means that it will be
adjusted to accommodate (approximately) both axial and off-axis beams without
truncation.
On the third line, which corresponds to the image (IMS) a RADIUS of 0.0 means
that the image is plane. Once again its size is the default - it is adjusted using a
“paraxial solve.” The box for the next space (THICKNESS) will used for a defocus
value, but is zero at present. The box showing the medium after the image
(GLASS) is of course blank.
There is no need to close the surface data spreadsheet before starting the next
section.

Drawing the lens in the Autodraw window
In the main window:
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•
•

Click on the Lens menu header to open the menu list shown.
Select the last item, Lens Drawing Conditions ...
The Lens Drawing Conditions spreadsheet will appear. This is the spreadsheet
where the overall appearance of lens system drawings is determined.

In the Lens Drawing Conditions spreadsheet:

•

After Image space rays: select Draw rays to image surface.

•

The table at the bottom determines what rays will be displayed. In the
column headed Rays type on the first line 11 for the number of rays to
be drawn for the first (on axis) field point - for which Frac Y Obj =
0.00000. These rays will be drawn with a green pen.

•

Leave everything else unchanged, and close with the green tick

.

The Autodraw window should now
have the appearance shown in the
diagram, provided the surface data
spreadsheet is open.

HELP! The Autodraw window
may be hidden behind one of the
others. If this happens to be the
case, from the Window menu
header select Tile Windows
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Plotting the on axis spot diagram
A spot diagram is a map of the pattern of
rays incident on the image from a single
object point, using the “geometrical
approximation” which ignores the wave
nature of light.

•

From the Evaluate menu header
select:

Spot Diagram
►Single spot diagram...
• In the Print or plot spot diagram
spreadsheet, click on three radio
buttons as shown:
Plot spot diagram.
Plot ray intersection points as:
Symbols
Show Airy disc in plot:
Yes
• Leave the other entries as defaults;
the axial (FBY = 0, FBX = 0) is the
default so there is no need to use the
Set Object Point button.

•

Click on _OK_

The colored symbols in this diagram
represent the distribution in the image plane
of rays which evenly fill the pupil from a
single point on axis. The three colors
representing the three default wavelengths.
The black circle represents the first minimum
of the Airy disc, which is the intensity in the
image of a perfect lens of the same aperture,
in monochromatic light of the default central
wavelength of 0.58756 μm.
The most important aspect of the diagram is
that all the rays fall within this circle. This is
one of the criteria by which the
assertion can be made:
Answer: Yes, the image quality at
the focal point is “diffraction
limited” - i.e. limited by the wave
nature of light and not by
aberrations.

HELP! Once again, if you have
trouble finding the graphics window,
from the Window menu header
select Tile Windows or type the command tile into the command line.
• Close the surface data spreadsheet by clicking on the green tick .
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Listing the lens surface data
• Click on the Len header in the text window to list radii, thicknesses,
apertures, glass types and surface notes.
*LENS DATA
Spherical mirror
SRF
RADIUS
OBJ
-AST
IMS

•

THICKNESS
1.0000e+20

-16.000000

-8.000000

--

--

1.000000 AS

GLASS
AIR

SPE

NOTE

REFL_HATCH

8.0000e-06 S

Click on Rin to list the indices and thermal expansion coefficients.

*REFRACTIVE INDICES
SRF GLASS/CATALOG
0
AIR
1
REFL_HATCH
2
IMAGE SURFACE

•

APERTURE RADIUS
1.0000e+14

RN1
1.000000
1.000000

RN2
1.000000
1.000000

RN3
1.000000
1.000000

VNBR
---

TCE
---

Click on Ape to list apertures and any special apertures.

*APERTURES
SRF
TYPE APERTURE RADIUS
0
SPC
1.0000e+14
1
CMP
1.000000
2
CMP
8.0000e-06

•

Click on Wav to give the wavelengths and the spectral weighting factors on
each.

*WAVELENGTHS
CURRENT WV1/WW1
1
0.587560
1.000000

•

WV2/WW2
0.486130
1.000000

WV3/WW3
0.656270
1.000000

Click on Pxc to list the focal length and some of the operating conditions.

*PARAXIAL CONSTANTS
Effective focal length:
Numerical aperture:
Working F-number:
Lagrange invariant:

-8.000000
0.125000
4.000000

Lateral magnification:
Gaussian image height:
Petzval radius:

-8.0000e-20
8.0000e-06
-8.000000

-1.0000e-06

HELP! There are occasions when the text
output gets turned off inadvertently. This is
most likely to occur if a CCL command is
interrupted before it has had time to complete
its task. If nothing appears in the text window
when text output is expected, look at the first
panel on the status bar at the bottom of the
main window. If it reads Text output: Off, right
click within the text window, and select the last
menu entry: Set Text Output On.
Saving the lens

Right

To create a new folder and save the lens in
it:

•
•

From the File menu header select

Save Lens as ...
Of the two buttons labeled Library
Directories at the bottom of the
Save Lens As window, click on

_Private_
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•

At the top of the window, click on the icon:

Create new folder
•
•
•

Type the name for the new folder: User_Guide and click on _Open_
Under File name type: spherical_mirror
Click on _Save_ to save the lens with the file name spherical_mirror.len
Note that OSLO is case insensitive, so this file cannot coexist with another file
called, for example, SPHERICAL_MIRROR.len
• Close the surface data spreadsheet with the green
tick
• The lens will be stored in the private lens directory
C:\Program Files\OSLO\EDU64\private\len (or
similar), in the newly created \User_Guide
subdirectory.

HELP! It sometimes happens that the program apparently
freezes, and any clicks only result in a gong-like
sound. When an error message appears, this needs
to be cleared by clicking on OK. If, however,
through an activity of the Windows operating
system, the error window has been hidden behind
another open window, it needs to be located and
closed before OSLO will work again.
Changing the aperture
Question:
If the aperture of the spherical mirror is increased to 3.44 mm is
it still “diffraction limited” at the new aperture?

•
•

In the Surface Data spreadsheet increase the entrance beam radius from 1
mm to 1.72 mm.
Confirm with the green tick .

Right

Now recalculate the spot diagram:
• Right-click anywhere inside the graphics window containing the spot
diagram plotted previously.
• Select Update window using current data:
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to give the diagram
shown.
Because the aperture has
increased, the spot
diagram is bigger (because
of greater aberrations) and
the Airy disc is smaller (it is
inversely proportional to
the aperture). Most of the
rays therefore now lie
outside the Airy disc circle.
No, it is far
Answer:
from diffraction limited.

Drawing the lens in the graphics window, with “zooming”
To draw the lens system in
a graphics window:
• From the Lens
menu header select

Lens Drawing ...
•

► System
Accepting all the
defaults click on

_OK_
Alternatively,
• Click on the first
icon in the graphics
window standard toolbar for
Draw system (2D plan view).
• Select Plan View ...
To view the paths of rays near the
focus at a higher magnification:

•
•

On the graphics window, leftclick-and-drag around the
focus as shown below.
Left click twice within the graphics window to return to the full frame image.
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Note that the zooming action will work on all graphics windows except the
Autodraw window.
Clearly a better focal plane can be chosen, a short distance to the right of the
current one.

Finding the best focal plane
Question:
At this new aperture, where should the focal plane be
chosen to give the best image quality for green light on axis?
This can be found most quickly using the “autofocus” facility in the surface data
spreadsheet, one of a number of built-in optimization functions.
• Open the Surface Data spreadsheet.
• Click on the grey button next to the thickness for the image surface (surface
IMS).
• Select Autofocus - minimize RMS OPD ...

► On-axis (monochromatic)
In this context, RMS OPD refers to the root mean square optical path difference (or
wave aberration). This autofocus action has the effect of finding the focal plane
which minimizes the RMS OPD and entering the necessary displacement as the
thickness for the image space. The thickness for the space preceding the image

space is left unchanged.
Listing the lens data:
• Click on the Len header in the text window - this gives the extent of defocus
needed:
*LENS DATA
Spherical mirror f/2.33
SRF
RADIUS
THICKNESS
OBJ
-1.0000e+20
AST

-16.000000

IMS
-0.005127 S

-8.000000

APERTURE RADIUS
1.0000e+14
1.720000 AS

SPE

NOTE

REFL_HATCH

0.023809

The value listed for the defocus, shown as the
thickness at the image plane, is 0.023809 mm.
To get the actual distance from the mirror to
the image it is necessary to add this the
defocus value to the nominal distance of -8
mm.
This is the only case in OSLO where an entry
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in the thickness column of the surface data spreadsheet for a surface affects the
axial position of that surface rather than the surface which follows.
Answer:
mirror.

The best focus at an aperture of f/2.33 is at 7.976 mm from the

Plotting the on axis point spread function (PSF)
Question:

Is the image “diffraction limited” at the new focal plane?

The evaluations carried out hitherto only show approximations to the actual
distribution of light in the image of a point source, since a spot diagram takes no
account of diffraction.
To plot the true distribution of light in the image of a monochromatic point source,
that is to say, the point spread function:

•

From the Evaluate menu
header select:

Spread Function
►Plot PSF Map/Contour...
In the Sprd window which opens:
• Click on the radio button
Grey scale map
• Click on the radio button
Monochromatic
• Type in 0.01 for the
Size of patch on image surface.
• Click on the radio button:
Normalize to peak of PSF
• Click on the radio button:
Direct integration
• Type in 128 for Number of

lines/points in drawing and
click on _OK_
Note that the first bright ring around
the central maximum can just be
seen.
Note also the figure at the top of the
scale on the right: 0.8123. This figure
is called the “Strehl ratio,” which is
the intensity at the central peak of
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the image of a point source measured as a fraction of the Airy diffraction pattern of
an ideal lens. If the Strehl ratio exceeds 0.8, a lens system is described as
“diffraction limited”.
Answer: Yes, the image is diffraction limited on axis at the new focal plane.

Extending the rays in the lens drawing
• Open the Lens Drawing Conditions

Edit Lens Drawing Conditions

spreadsheet by clicking on the icon in the main window toolbar.

• After Initial distance enter 16.
• Close the spreadsheet with the green tick

.

Calculating the off axis optical path difference (OPD)
Question:
What is the maximum OPD at full field for a semi-field angle of
18° (total field angle 36°)?
• Open the Surface Data spreadsheet.
• Enter 18.0 degrees as the (semi-field) Field angle
• Left click on the grey SRF button for surface 1 (AST) to highlight the whole
row.
• Right click to bring up the menu of options.
• Select Insert before to insert a new surface as surface 1.

Right
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•
•

Under APERTURE RADIUS for the new surface 1, click on the grey button.
Select Aperture stop (A)

The aperture stop indication (AST) on the grey button under SRF will now move to
surface 1, which at the moment is in contact with surface 2.
Note that the aberrations of the rays in the off-axis beam (drawn in blue) are so
large that they can easily be seen in the lens drawing.
To calculate the optical path difference, or wave aberration, over the whole pupil for
three field points (on axis, 0.7 field and full field):

•

From the Evaluate menu header
select:

Wavefront ►Report graphic...
and in the dialog box which opens:
• Enter 128 as the Number of lines
• Select Reference ray
intersection
• Click on _OK_
Note the peak-to-valley figure of 37.05
wavelengths under the map for the full field wave
aberration.
Answer: The axial performance is better than
the standard criterion of a quarter of a
wavelength for the diffraction limit, but at full
field off axis the maximum OPD is 37
wavelengths.
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Optimizing
The aperture stop is the limiting aperture of the axial beam. Its longitudinal position
determines the beam which is selected to form the off-axis image, and if the field is
large, this can have a significant effect on image quality.
Also the image has been assessed only over a plane surface - this is of course the
usual convention. For this exercise, however, we will investigate the benefits of
allowing the image to become curved.
Question: Where should the stop be placed, and what curvature of the image
is needed, to obtain the best performance over the whole field?
Open the slider wheel spreadsheet

The answer to this question will demonstrate slider wheel
optimization, one of the most useful features of OSLO.
• Close the surface data spreadsheet.
• Open the Slider-wheel Setup spreadsheet, by clicking on
the icon on the main window header.

The entries above the line define the contents of the window(s) which will be
displayed during slider-wheel optimization.
• Select OPD (optical path difference, another name for wavefront
aberration)
• Select All points
Entries below the line determine which parameters will be adjusted with sliderwheels:
• Leave the default of 2 for the Number of sliders (up to 32 can be defined at
any one time).
• On the first line, enter 1 under Surf and type
th in the box under Item. Alternatively click
on the box and select Thickness (TH) from
the menu of options.
• On the second line, enter 3 under Surf and
type cv under Item.
• Click on the green tick to close the Sliderwheel Setup spreadsheet.
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The two graphics window which open, GW31 and GW32, are specific to sliderwheel optimization. The scrollbar at the right of each slider wheel track can be used
to adjust the step increment of the slider-wheel motion. Changing the step size also
has the effect of centralizing the slider-wheel in the track.

•

Watching the lens drawing in GW 32, and the plots of the optical path
difference in GW 31, move the upper slider to the extreme right (TH 1 = 10)
and the lower slider to the extreme left (CV 3 = -0.1).

•

Once again, open the Slider-wheel Setup spreadsheet, by
clicking on the icon. However this time just close it again
immediately. This has the effect of centralizing the two sliderwheels and re-drawing both windows with different scales.

Although the OPD
graphs give no indication
of scale, it can be seen
that the performance is
much improved.

•

Repeat the
sequence once
more until the
best result is
given. This should
be when TH 1 =
16.0 mm and CV
3 = -0.125 mm-1

Answer:
The aperture stop must be at the centre of curvature of the
mirror, and the image surface must be a sphere with its centre at the aperture
stop.
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Assessing the final design
To evaluate the optical path difference of the new system, once again:
• From the Evaluate menu header select:

Wavefront ►Report graphic...
and in the dialog box which opens:
• Enter 128 as the Number of lines
• Select Reference ray
intersection
• Click on _OK_
The peak-to-valley wave aberration at
the edge of the field is less than a
quarter wavelength, so the lens is
diffraction limited over the whole
(curved) field.

Listing the data
To list the correct prescription of the
final design, the image separation
needs to be adjusted. In the command line:
• Enter the command: th 2 -7.976 (note the spaces after th and after
2)
SRF
TH

2:
-7.976000

•
SRF
TH

Enter the command: th 3 0;rtg to give the final listing (again note the
spaces):
3:
--

*LENS DATA
Spherical mirror
SRF
RADIUS
OBJ
--

THICKNESS
1.0000e+20

APERTURE RADIUS
3.2492e+19

AST

--

16.000000

1.720000 AS

2

-16.000000

-7.976000

6.918715 S

IMS

•

-8.000000

--

GLASS
AIR

SPE

NOTE

AIR
REFL_HATCH

2.612316 S

Click on the save lens icon in the main toolbar to save the lens.

Exiting the program
• From the File menu header select Exit

•

If any more changes have been made a
message label will give a warning to
save the lens, otherwise those changes
will be lost.
Click on _No_ and the program terminates.
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4.

Conclusion

This tutorial shows how OSLO commands can be
accessed either from the menu headers, from the text
window headers, from icons or entered directly into the
command line.
Command names are important for accessing the
documentation in the on-line help. Here are some of
the commands that have been used (either explicitly or
via the menus and icons) in this chapter:
file_new

Opens a new lens file

uoc drl

Updates lens drawing conditions

pls

Plots spot diagram

len

Lists lens data

save

Saves lens

drl

Draws lens

auf

Autofocus

sprd

Plots the point spread function

lse

Opens the surface data spreadsheet

rpt_wvf

Plots wavefront map at 3 field points

swe

Opens the slider-wheel spreadsheet

th

Changes a thickness

rtg

Lists radii/thicknesses/glass types

exit

Terminates OSLO.

To obtain a full list of commands:

•
•

From the Help menu header select OSLO
Help F1
Select the Contents tab and click on
Command Reference. The commands are
listed in the alphabetic sub-directories
shown here.
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